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Getting to know Excel
If you've previously used Excel 2010 or Excel 2013, then Excel 2016 should
feel familiar. If you are new to Excel or have more experience with older
versions, you should first take some time to become familiar with
the Excel interface.

The Excel interface
When you open Excel 2016 for the first time, the Excel Start Screen will
appear. From here, you'll be able to create a new workbook, choose
a template, and access your recently edited workbooks.


From the Excel Start Screen, locate and select Blank
workbook to access the Excel interface.
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Click the buttons in the interactive below to become familiar with the Excel
interface.
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Working with the Excel
environment
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The Ribbon and Quick Access Toolbar are where you will find the
commands to perform common tasks in Excel. The Backstage view gives
you various options for saving, opening a file, printing, and sharing your
document.

The Ribbon
Excel 2016 uses a tabbed Ribbon system instead of traditional
menus. The Ribbon contains multiple tabs, each with several groups of
commands. You will use these tabs to perform the most common tasks in
Excel.


Each tab will have one or more groups.



Some groups will have an arrow you can click for more
options.
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Click a tab to see more commands.



You can adjust how the Ribbon is displayed with the Ribbon
Display Options.

Certain programs, such as Adobe Acrobat Reader, may install additional
tabs to the Ribbon. These tabs are called add-ins.

To change the Ribbon Display Options:
The Ribbon is designed to respond to your current task, but you can
choose to minimize it if you find that it takes up too much screen space.
Click the Ribbon Display Options arrow in the upper-right corner of the
Ribbon to display the drop-down menu.
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There are three modes in the Ribbon Display Options menu:


Auto-hide Ribbon: Auto-hide displays your workbook in
full-screen mode and completely hides the Ribbon. To show
the Ribbon, click the Expand Ribbon command at the top
of screen.



Show Tabs: This option hides all command groups when
they're not in use, but tabs will remain visible. To show the
Ribbon, simply click a tab.
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Show Tabs and Commands: This option maximizes the
Ribbon. All the tabs and commands will be visible. This
option is selected by default when you open Excel for the
first time.

The Quick Access Toolbar
Located just above the Ribbon, the Quick Access Toolbar lets you access
common commands no matter which tab is selected. By default, it
includes the Save, Undo, and Repeat commands. You can add other
commands depending on your preference.

To add commands to the Quick Access
Toolbar:
1. Click the drop-down arrow to the right of the Quick Access Toolbar.
2. Select the command you want to add from the drop-down menu. To choose from
more commands, select More Commands.
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3. The command will be added to the Quick Access Toolbar.

How to use Tell me:
The Tell me box works like a search bar to help you quickly find tools or
commands you want to use.
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1. Type in your own words what you want to do.

2. The results will give you a few relevant options. To use one, click it like you would
a command on the Ribbon.
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Worksheet views
Excel 2016 has a variety of viewing options that change how your
workbook is displayed. These views can be useful for various tasks,
especially if you're planning to print the spreadsheet. To change
worksheet views, locate the commands in the bottom-right corner of the
Excel window and select Normal view, Page Layout view, or Page Break
view.
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Normal view is the default view for all worksheets in Excel.



Page Layout view displays how your worksheets will appear
when printed. You can also add headers and footers in this
view.
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Page Break view allows you to change the location of page
breaks, which is especially helpful when printing a lot of data
from Excel.
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Backstage view
Backstage view gives you various options for saving, opening a file,
printing, and sharing your workbooks.
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To access Backstage view:
1. Click the File tab on the Ribbon. Backstage view will
appear.

Click the buttons in the interactive below to learn more about using
Backstage view.
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Challenge!
1. Open Excel 2016.
2. Click Blank Workbook to open a new spreadsheet.
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3. Change the Ribbon Display Options to Show Tabs.
4. Using the Customize Quick Access Toolbar, click to add New, Quick Print,
and Spelling.
5. In the Tell me bar, type the word Color. Hover over Fill Color and choose
a yellow. This will fill a cell with the color yellow.
6. Change the worksheet view to the Page Layout option.
7. When you're finished, your screen should look like this:

8. Change the Ribbon Display Options back to Show Tabs and Commands.
(Close Excel and Don't Save changes.)

Understanding cells
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Every worksheet is made up of thousands of rectangles, which are
called cells. A cell is the intersection of a row and a column—in other
words, where a row and column meet.
Columns are identified by letters (A, B, C), while rows are identified
by numbers (1, 2, 3). Each cell has its own name—or cell address—based
on its column and row. In the example below, the selected cell
intersects column C and row 5, so the cell address is C5.

Note that the cell address also appears in the Name box in the top-left
corner, and that a cell's column and row headings are highlighted when
the cell is selected.
You can also select multiple cells at the same time. A group of cells is
known as a cell range. Rather than a single cell address, you will refer to a
cell range using the cell addresses of the first and last cells in the cell
range, separated by colon. For example, a cell range that included cells A1,
A2, A3, A4, and A5 would be written as A1:A5. Take a look at the different
cell ranges below:
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Cell range A1:A8
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Cell range A1:F1



Cell range A1:F8

If the columns in your spreadsheet are labeled with numbers instead of
letters, you'll need to change the default reference style for Excel. Review
our Extra on What to learn how.

To select a cell:
To input or edit cell content, you'll first need to select the cell.
1. Click a cell to select it. In our example, we'll select cell D9.
2. A border will appear around the selected cell, and the column heading and row
heading will be highlighted. The cell will remain selected until you click another
cell in the worksheet.
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You can also select cells using the arrow keys on your keyboard.

To select a cell range:
Sometimes you may want to select a larger group of cells, or a cell range.
1. Click and drag the mouse until all of the adjoining cells you want to select
are highlighted. In our example, we'll select the cell rangeB5:C18.
2. Release the mouse to select the desired cell range. The cells will remain
selected until you click another cell in the worksheet.
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Cell content
Any information you enter into a spreadsheet will be stored in a cell. Each
cell can contain different types of content,
including text, formatting, formulas, and functions.


Text: Cells can contain text, such as letters, numbers, and
dates.



Formatting attributes: Cells can contain formatting
attributes that change the way letters, numbers, and dates
are displayed. For example, percentages can appear as 0.15
or 15%. You can even change a cell's text or background
color.
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Formulas and functions: Cells can
contain formulas and functions that calculate cell values. In
our example, SUM(B2:B8) adds the value of each cell in the
cell range B2:B8 and displays the total in cell B9.

To insert content:
1. Click a cell to select it. In our example, we'll select cell F9.
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2. Type something into the selected cell, then press Enter on your keyboard. The
content will appear in the cell and the formula bar. You can also input and edit
cell content in the formula bar.

To delete (or clear) cell content:
1. Select the cell(s) with content you want to delete. In our example, we'll select the
cell range A10:H10.
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2. Select the Clear command on the Home tab, then click Clear Contents.

3. The cell contents will be deleted.
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You can also use the Delete key on your keyboard to delete content
from multiple cells at once. The Backspace key will only delete content
from one cell at a time.

To delete cells:
There is an important difference between deleting the content of a cell and
deleting the cell itself. If you delete the entire cell, the cells below it
will shift to fill in the gaps and replace the deleted cells.
1. Select the cell(s) you want to delete. In our example, we'll selectA10:H10.
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2. Select the Delete command from the Home tab on the Ribbon.

3. The cells below will shift up and fill in the gaps.
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To copy and paste cell content:
Excel allows you to copy content that is already entered into your
spreadsheet and paste that content to other cells, which can save you
time and effort.
1. Select the cell(s) you want to copy. In our example, we'll select F9.
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2. Click the Copy command on the Home tab, or press Ctrl+C on your keyboard.

3. Select the cell(s) where you want to paste the content. In our example, we'll
select F12:F17. The copied cell(s) will have a dashed box around them.
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4. Click the Paste command on the Home tab, or press Ctrl+V on your keyboard.

5. The content will be pasted into the selected cells.
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To access more paste options:
You can also access additional paste options, which are especially
convenient when working with cells that contain formulas or formatting.
Just click the drop-down arrow on the Paste command to see these
options.
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Instead of choosing commands from the Ribbon, you can access
commands quickly by right-clicking. Simply select the cell(s) you want
to format, then right-click the mouse. A drop-down menu will appear,
where you'll find several commands that are also located on the Ribbon.
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To cut and paste cell content:
Unlike copying and pasting, which duplicates cell content, cutting allows
you to move content between cells.
1. Select the cell(s) you want to cut. In our example, we'll select G5:G6.
2. Right-click the mouse and select the Cut command. Alternatively, you can use the
command on the Home tab, or press Ctrl+X on your keyboard.

3. Select the cells where you want to paste the content. In our example, we'll
select F10:F11. The cut cells will now have a dashed box around them.
4. Right-click the mouse and select the Paste command. Alternatively, you can use
the command on the Home tab, or press Ctrl+V on your keyboard.
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5. The cut content will be removed from the original cells and pasted into the
selected cells.
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To drag and drop cells:
Instead of cutting, copying, and pasting, you can drag and drop cells to
move their contents.
1. Select the cell(s) you want to move. In our example, we'll selectH4:H12.
2. Hover the mouse over the border of the selected cell(s) until the mouse changes to
a pointer with four arrows.
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3. Click and drag the cells to the desired location. In our example, we'll move them
to G4:G12.
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4. Release the mouse. The cells will be dropped in the selected location.
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To use the fill handle:
If you're copying cell content to adjacent cells in the same row or column,
the fill handle is a good alternative to the copy and paste commands.
1. Select the cell(s) containing the content you want to use, then hover the mouse over
the lower-right corner of the cell so the fill handle appears.
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2. Click and drag the fill handle until all of the cells you want to fill are selected. In
our example, we'll select G13:G17.
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3. Release the mouse to fill the selected cells.
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To continue a series with the fill
handle:
The fill handle can also be used to continue a series. Whenever the
content of a row or column follows a sequential order, like numbers (1, 2,
3) or days (Monday, Tuesday, Wednesday), the fill handle can guess what
should come next in the series. In most cases, you will need to
select multiple cells before using the fill handle to help Excel determine
the series order. Let's take a look at an example:
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1. Select the cell range that contains the series you want to continue. In our example,
we'll select E4:G4.
2. Click and drag the fill handle to continue the series.

3. Release the mouse. If Excel understood the series, it will be continued in the
selected cells. In our example, Excel added Part 4, Part 5, and Part 6to H4:J4.
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Challenge!
1. Open our practice workbook.
2. Select cell D6 and type hlee.
3. Clear the contents in row 14.
4. Delete column G.
5. Using either cut and paste or drag and drop, move the contents of row 18 to row
14.
6. Use the fill handle to put an X in cells F9:F17.
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7. When you're finished, your workbook should look like this:

Introduction to Formulas
One of the most powerful features in Excel is the ability
to calculate numerical information using formulas. Just like a calculator,
Excel can add, subtract, multiply, and divide. In this lesson, we'll show you
how to use cell references to create simple formulas.
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Optional: Download our practice workbook.
Watch the video below to learn more about groups and subtotals in Excel.

Mathematical operators
Excel uses standard operators for formulas, such as a plus sign for
addition (+), a minus sign for subtraction (-), an asterisk for multiplication
(*), a forward slash for division (/), and a caret (^) for exponents.

All formulas in Excel must begin with an equals sign (=). This is because
the cell contains, or is equal to, the formula and the value it calculates.

Understanding cell references
While you can create simple formulas in Excel using numbers (for
example, =2+2or =5*5), most of the time you will use cell addresses to
create a formula. This is known as making a cell reference. Using cell
references will ensure that your formulas are always accurate because you
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can change the value of referenced cells without having to rewrite the
formula.
In the formula below, cell A3 adds the values of cells A1 and A2 by making
cell references:

When you press Enter, the formula calculates and displays the answer in
cell A3:

If the values in the referenced cells change, the formula automatically
recalculates:

By combining a mathematical operator with cell references, you can create
a variety of simple formulas in Excel. Formulas can also include a
combination of cell references and numbers, as in the examples below:
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To create a formula:
In our example below, we'll use a simple formula and cell references to
calculate a budget.
1. Select the cell that will contain the formula. In our example, we'll select cell D12.
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2. Type the equals sign (=). Notice how it appears in both the cell and the
formula bar.

3. Type the cell address of the cell you want to reference first in the formula:
cell D10 in our example. A blue border will appear around the referenced cell.

4. Type the mathematical operator you want to use. In our example, we'll type
the addition sign (+).
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5. Type the cell address of the cell you want to reference second in the formula:
cell D11 in our example. A red border will appear around the referenced cell.

6. Press Enter on your keyboard. The formula will be calculated, and the value will
be displayed in the cell. If you select the cell again, notice that the cell displays the
result, while the formula bar displays the formula.
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If the result of a formula is too large to be displayed in a cell, it may appear
as pound signs (#######) instead of a value. This means the column is not
wide enough to display the cell content. Simply increase the column
width to show the cell content.

Modifying values with cell references
The true advantage of cell references is that they allow you
to update data in your worksheet without having to rewrite formulas. In
the example below, we've modified the value of cell B1 from $1,200 to
$1,800. The formula in B3 will automatically recalculate and display the
new value in cell B3.

Excel will not always tell you if your formula contains an error, so it's up
to you to check all of your formulas. To learn how to do this, you can read
the Double-Check Your Formulas lesson from our Excel
Formulas tutorial.

To create a formula using the pointand-click method:
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Instead of typing cell addresses manually, you can point and click the cells
you want to include in your formula. This method can save a lot of time
and effort when creating formulas. In our example below, we'll create a
formula to calculate the cost of ordering several boxes of plastic
silverware.
1. Select the cell that will contain the formula. In our example, we'll select cell D4.

2. Type the equals sign (=).
3. Select the cell you want to reference first in the formula: cell B4 in our example.
The cell address will appear in the formula.
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4. Type the mathematical operator you want to use. In our example, we'll type
the multiplication sign (*).
5. Select the cell you want to reference second in the formula: cell C4 in our example.
The cell address will appear in the formula.
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6. Press Enter on your keyboard. The formula will be calculated, and the value will
be displayed in the cell.
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Copying formulas with the fill handle
Formulas can also be copied to adjacent cells with the fill handle, which
can save a lot of time and effort if you need to perform the same
calculation multiple times in a worksheet. The fill handle is the small
square at the bottom-right corner of the selected cell(s).
1. Select the cell containing the formula you want to copy. Click and drag the fill
handle over the cells you want to fill.

2. After you release the mouse, the formula will be copied to the selected cells.
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To edit a formula:
Sometimes you may want to modify an existing formula. In the example
below, we've entered an incorrect cell address in our formula, so we'll
need to correct it.
1. Select the cell containing the formula you want to edit. In our example, we'll select
cell D12.

2. Click the formula bar to edit the formula. You can also double-click the cell to
view and edit the formula directly within the cell.
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3. A border will appear around any referenced cells. In our example, we'll change the
first part of the formula to reference cell D10 instead of cellD9.

4. When you're finished, press Enter on your keyboard or select the Enter command
in the formula bar.
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5. The formula will be updated, and the new value will be displayed in the cell.

If you change your mind, you can press the Esc key on your keyboard or
click the Cancel command in the formula bar to avoid accidentally making
changes to your formula.
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To show all of the formulas in a spreadsheet, you can hold the Ctrl key and
press `(grave accent). The grave accent key is usually located in the topleft corner of the keyboard. You can press Ctrl+` again to switch back to
the normal view.

Challenge!
1. Open our practice workbook.
2. Click the Challenge tab in the bottom-left of the workbook.
3. Create a formula in cell D4 that multiplies the quantity in B4 by the price per unit
in cell C4.
4. Use the fill handle to copy the formula in cell D4 to cells D5:D7.
5. Change the price per unit for the fried plantains in cell C6 to $2.25. Notice that the
line total automatically changes as well.
6. Edit the formula for the total in cell D8 so it also adds cell D7.
7. When you're finished, your workbook should look like this:
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